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Chapter 1

Chapter 1

Welcome

Sage Personal Tax will help you prepare the SA100 tax returns for individuals. Tax computations are

managed by Personal Tax, making the process of completing the return much simpler.

You have everything you need to complete an SA100 or R40 tax return within Sage Personal Tax.

If a client owns a business or is a partner in a business, calculating their tax liability can be much

simpler by using Business Tax and Partnership Tax. Both of these programs can calculate the client's

taxable income and transfer it to Personal Tax.

Finding your way around

The main Sage Personal Tax window is made up of the following areas:

Main Menu and Toolbar: From here you can access all the functions in Personal Tax. For

example, this is where you roll the client's data forward to a new tax year. All the functions

can be found in the main menu, but some frequently used functions are also available on the

toolbar for easy access.
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Annual Data Navigator: You may well be familiar with the 'tree' stricture of folders from other

Windows programs. Each folder in the tree represents an area of tax. You will be using the

Navigator extensively to enter your client information.

Data Entry window: This is where you view and enter your client information. This window

displays the page you've selected from the navigator.

The Personal Tax workflow

This is a quick overview of the steps that you have to take in order to complete a tax return for one

of your clients.

1 - Create a client
You can create a client from Personal Tax, Control Centre, or Sage Practice Solution.

If you use Sage Practice Solution and have client integration enabled, clients created in any Sage

Taxation program will automatically be available in Sage Practice Solution. For more information,

see Connecting your Sage programs on page 5.

If you are producing a tax return for a client for the first time, you will have to set the client up for

Personal Tax. You only have to do this once; the client is then kept in Sage Taxation so you can

continue to complete tax returns for them year on year.

For more information, see Creating clients on page 4.

2 - Complete the Event Log
Next you will have to complete the client’s event log. This is where you record events in the client’s

life that Personal Tax would have to be aware of in order to accurately calculate their allowances

(e.g. date of birth, marriage, registering as blind).

For more information about the Event Log, see Events & Family Log on page 7 .

3 - Collect your client's income data using the Annual Data Questionnaire
To help you collect your client’s income data, Personal Tax has the facility to produce income

questionnaires that you can send to clients which when completed will provide you with all the

income information you require to complete the client’s tax return.

For more information about the ADQ, see The Annual Data Questionnaire on page 10

4 - Enter the client's income details
Once the client is set up you can start entering the details of the client’s income on the forms in the

Annual Data Navigator for this tax year (in addition to any data you transferred from other Sage

Taxation applications). At any time during this process you can check how the SA100 tax return will

look using the data you have entered so far and create ‘snapshot’ copies of these for future

reference.

For more information about entering income details, see Data entry forms on page 13.

5 - Validate the return
After you have entered all the data, you can use Personal Tax to validate the return before you print

it. This will make a series of automated checks on the return to ensure that the data is valid andwill
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not be rejected by the Revenue. If there are any problems, Personal Tax will list them for you.

For more information, see Find errors with the return on page 19.

6 - Generate the final return
Once you are satisfied that you have completed entering the data for the clients, you can then

generate the final return for submission to the Inland Revenue. You can submit the return in two

ways:

By post: print a paper copy from Personal Tax;

Via the Filing by Internet service: click FBI on the toolbar.

For more information, see Submitting the tax return on page 22.

Annual Data Navigator

The Annual Data Navigator is a visual representation of the client's income, outgoings and

allowances for the tax year in question.

It shows at a glance what data has been entered andwhether it is complete.

It also helps you navigate through the different tax areas.

The navigator has a multi-level structure of folders that contain the data entry forms in which you

enter tax information for the client. The Annual Data Navigator offers two different views of your

data: the default hierarchical view or tree view, and an alphabetical view.

Changing tax years

The navigator displays one tax year at a time for the selected client. The tax year currently selected

is shown in the drop-down list at the top of the navigator.
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Creating clients

There are three ways to create a client that can be used in Personal Tax:

Creating clients in Personal Tax will set up the client with the details needed to start entering

information for tax return processing.

If you use Sage Practice Solution and have client integration enabled, clients created in any

Sage Taxation program will automatically be available in Sage Practice Solution. For more

information see Connecting your Sage programs on page 5

Using Control Centre, you can set up clients for any program in Sage Taxation.

Creating clients in Sage Practice Solution gives you the benefit that your details will be

available to all of the subscribed service programs for the client. If you use Sage Time and

Fees, this will also allow you to create jobs and record time against your clients.

To add a client:

Note: If you use Sage Practice Solution and have client integration enabled, clients created in Sage

Taxation will automatically be available in Sage Practice Solution. For more information see

Connecting your Sage programs on page 5.

1. From the File menu, choose New. The Select Dataset window appears.

2. Select the dataset where the client is to be created, then click Select.

3. The New Individual Wizard appears. Click Next.

4. Enter the Personal Details of the client then click Next.

Tip: If you need to quickly create a client, you can click Complete at this stage. You will be

able to edit the rest of the details later.

5. Enter the contact and tax details then click Next.

6. Provide a client code. Personal Tax will suggest one but you may want to tie this into an

existing scheme in your practice. Fill in the rest of the page then click Next.

7. Select the first year you will be entering tax data. You can also enter a date of birth for the

client. Click Next.

8. Select which staff members to assign to the client. Click on the magnifying glass button to

see a look upwindow. Click Next.

9. Choose whether to password protect the client andwhether to include in reports. Click Next

then Finish to create the client.

For more detailed information about each page of the wizard, click Help on the wizard as you create

the client.
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Connecting your Sage programs

With Practice Solution you can share your client data between Sage products for practice.

Connected programs:

Sage Accounts Production

Sage Accounts Production

Advanced

Sage Corporation Tax

(powered by Abacus)

Sage Taxation

When you install Practice Solution, or any of the products listed above, the connections will not be

enabled. This is to make sure that you are comfortable with your new software before you begin

sharing your client data.

Note: Sage 50 Accounts is used by Practice Solution for billing. This integration is available in

Practice Solution after the billing system has been configured in Sage Practice Solution Control

Panel.

Connecting with Sage Practice Solution

Sage Practice Solution allows you tomanage your clients’ details, link to other Sage products for

practice, record time against work carried out for them and create invoices based on that time.

The software comprises two elements:
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Practice Hub

Time recording and invoicing

Your licence agreement with Sage will determine which elements are available.

Sage Practice Hub is the central store for your client data. You can use Sage Practice Hub to connect

your Sage Programs, for tasks, communications, reporting, letter writing etc.

We refer to Sage Practice Hubwith Time recording and invoicing as Sage Practice Solution.

More information

For more information about connecting your Sage programs with Sage Practice Solution, start Sage

Practice Solution (v1.5 or above) and from the Helpmenu choose Contents. When the Help system

appears, use the table of contents to find the book Connecting your Sage Programs.
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Events & Family Log

Use the Events & Family Log tomanage the relationships and events that have occurred in the

client's life which have important tax implications.

For example, if a client has been registered blind you should enter the date and local authority in the

event log. Personal Tax will recognise that the client is eligible to claim blind person's allowance and

will mark the allowance form as such.

You can open the Events & Family Log in the followingways:

Select Personal Details > Events & Family Log in the navigator.

Click Events on the toolbar.

Choose Event Log from the Tools menu.

From Control Centre.

If you have created any relationships within Sage Practice Solution such as marriages or children for

this client, the details will come through to Personal Tax andwill be available in the Events & Family

Log.

The first column in the Events & Family Logwindow relates to the client (in this case, James

Nielson). Any subsequent columns correspond to people related to the client, such as partners or

children.

Each column has a number of rows:

The title row indicates the type of person in each column (for example, client, spouse or civil

partner, or child).

The second row shows the name of the person to whom the events in each column relate.

Subsequent rows contain details of the events that have been entered for each person.
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Add an event

Follow the instructions below to add an event for a client.

How to add an event:

1. Open the Events & Family Log.

2. Click Add on the toolbar. The Event Details window appears.

Note: The Details button becomes available when you have linked to another person. The

Details button will open the Client Details for the linked client.

3. Use the Event drop-down list to choose the event to add, then fill in the details. Click OK to

add the event.

As you’ve made a change to the Events & Family Log, when you close the form the following

message appears:

"Changes have been made in the Events & family Logwhich may affect the allowances this client

can claim. Do you want to automatically update the allowances? Click ’No’ to manually change the

allowances later."

This is because the Events & Family Log is closely linked to the Allowances in Personal Tax. Personal

Tax automatically links events and allowances together, so that the details of events that you add or

change in the Events & Family Log are automatically entered in the Allowances section.

Click Yes if you want Personal Tax to automatically work out the allowances or No to change the

allowances details yourself.

Changing existing events

Once you've added events, you can change the event details by opening the Events & Family Log,

selecting the item to change and clicking Edit. Events can be deleted by selecting the event and

clicking Delete.

Remember that changes you make to event may adjust the allowances for the client.
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Claim allowances

As we've already mentioned, allowances are closely linkedwith the Events & Family Log: a client's

allowances are based on events.

Allowances that can be claimedwith Personal Tax are:

Personal allowance

Age related allowance

Married couples' allowance

Blind person's allowance

In the majority of cases you will not need to open the allowances form. Personal Tax looks after all

the allowances based on details you've entered in the Events Log.

You can however use the allowances form to transfer surplus allowances for either Married Couples'

Allowance or Blind Person's Allowance.
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The Annual Data Questionnaire

The Annual Data Questionnaire (ADQ) is a way of gathering and/or confirming tax data for an

individual. ADQs can be useful as a data confirmation exercise just before the new tax year, or could

be used as an information-gathering device when new clients are created.

Any information that can be entered into Personal Tax for an individual can be included on an ADQ.

Annual Data Questionnaires can be producedwithin Personal Tax and Control Centre:

Personal Tax will allow you to produce an ADQ for one client at a time. Select Annual Data

Questionnaire from the Tools menu to set up the ADQ.

Control Centre will allow you to produce ADQs for any number of clients at once by selecting

from a range or filtering the client list. Select Annual Data Questionnaire (ADQ) from the

Tools menu to see the options for configuring and creating ADQs.

The ADQ can also be created in any of the following three formats.

Standard (Comparative) format: This option will create the ADQ in a questionnaire format in the

same kind of style as the report generator. This format will print the data existing in the system for

the currently selected year and leave a blank space for the client or client’s representative to

complete any changes for the new tax year. Standard ADQs can be produced singly via Personal Tax

or as a batch via Control Centre.

You can also create a cover letter to accompany the Standard ADQ. This can be configuredwithin

Control Centre and is produced via the Batch Production wizard in Control Centre.

Letter (Text Based) format: This option will create the ADQ as a letter within MSWord. You can use

the template supplied with the software or create your own template for the letter and the text that

will be included for each section of the letter. Letter templates are added, amended and deleted

within Control Centre. Letters ADQs can be produced singly via Personal Tax or as a batch via Control

Centre.

Preparing the Annual Data Questionnaire

The following explains how to create an Annual Data Questionnaire for an individual client in

Personal Tax

To prepare an ADQ:

1. Open the client in Personal Tax and select the tax year previous to the year you want to

produce and ADQ for.

2. From the Tools menu, choose Annual Data Questionnaire. The Print Annual Data

Questionnaire window appears.
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3. Choose whether to produce a standard or Letter format.

A Standard ADQ displays last year's details in a report format with spaces alongside for

this year's data.

The Letter ADQ uses Microsoft Word. You can change the content of the ADQ using

Control Centre.

4. Click the Sections tab.

ADQ sections can either be forced to appear, suppressed or appear when data exists for the

last year. Use the lower pane to change which sections will be included. For a new client, you

may want to include all sections in the questionnaire by clicking Include All.

5. When you've decidedwhich sections to include, you may decide to save your preferences as

your practice defaults. To do this click Set Default.

6. Once you make any deviation away from the default, the window indicates that Personalised

settings are in use for this client.

7. Click Preview to see the report before you print it.

8. If you are happy with the report, you can choose to print it, or save as PDF. If you want to

make changes to the report, close the ADQ preview,make your changes and click Preview

again to see the result.

Letter (text based) format

You can produce the ADQ as a letter usingMicrosoft Word.

Each section has a template of predefined text. If that section is included in the ADQ, then the text

will be used.
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When you choose Letter (Text Based) format on the Print Annual Data Questionnaire window, you

will then be able to choose a template to use from a drop-down list. A Sage template is included for

you to use, but you can amend this, or you can create your own templates. You should do this in

Control Centre. See the ADQ Letter (Text Based) Template Configuration section of the Control

Centre Help for more information on templates.
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Data entry forms

Once the client is set up you can start entering the details of the client's income for this tax year.

Data is entered using the Data Entry Forms; the windows that appear when you click on items in

the Annual Data Navigator.

Data entry forms are where you enter information that is used in a client's tax return. Most data

entry forms are organised into a number of tab pages.

At the top of most data entry forms, you'll find three check boxes.

Auto Calc

When you open a form, you'll see that this option has been selected for you.With autocalc

selected, Personal Tax will calculate the figures for the tax return in this area.

If you clear this option, a Summary tab will appear. You can click the Summary tab and see

the figures that the program had calculated and intended to send to the tax return. You can

however change these summary figures but remember that if you do this, you're taking

responsibility for your own calculations.

Estimated

You can mark figures as estimated to give you a visual cue on the navigator. Estimated

figures don't appear as such on the tax return.

You may want to mark figures as estimated if:

a valuation is required,

there is inadequate information to enable you to arrive at a reliable figure.

You cannot choose to omit figures if they are not known. Instead estimates must be entered.

Complete

Personal Tax judges when an item is complete and ticks this check box. If you're satisfied that

you've entered sufficient information for the tax return, you can mark an item complete at

any time.

When an item is marked as complete, a tick will appear on it in the navigator.

How do I use data entry forms?

Data entry forms are the primary way to enter information into Personal Tax. When you double-click

on most of the items in the navigator, a data entry form appears in the space on the right.
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Each form will handle a specific aspect of the client's tax situation, such as Residency status,

Employment details, and Capital Gains.

When you have a form open, you should save the data before moving on to a different area or a

different client. Clicking OK on each form will save it and close the form, clicking Apply will save the

changes but leave the form open, and clicking Cancel will discard any changes you've made and

close the form.

Help is available for most of the data entry forms. Click Help or press F1 on your keyboard.

To add a new employment for a client

1. Open the client and select the correct tax year. Personal Tax will open the client for the tax

year last ended based upon the system date.

2. Using the Annual Data Navigator, select Earned income > Employments > Add new

'Employment'

3. Double-click Add new 'Employment'. The Employment Details and Income data entry form

appears in the right-hand pane.

4. Fill in the form.

5. At the top of the form there are three check boxes that are common amongst all data entry

forms.
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Select Estimated to indicate that some of the figures you've entered on the form are

estimates. This does not appear on the Tax Return but a mark appears beside the

item in the navigator as a reminder.

If you have entered sufficient details for the Tax Return, Personal Tax will mark the

data entry form as complete. You may choose tomark this complete manually.

With Autocalc ticked, Personal Tax will use the details entered in the data entry form

to calculate the figures to send to the Tax Return. You can override this by clearing

the Auto-calc check-box and entering your own summary figures in the Summary

tab.

6. When you have entered the details for the employment, click OK to save the changes.

7. The employment will appear in the navigator. Double-clicking the employment will expand

the item and reveal further sections that can be completed. To complete a further section,

click the plus symbol next to the section, then double-click the 'Add new' item.
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Viewing the tax return

At any time during this process you can check how the SA100 tax return will look, using the data

you've entered so far (also known as the current working figures). The tax return will be generated

based on data currently entered for the client. The only way to change the information displayed on

a return or report is to edit the information entered into the data entry forms.

The tax return opens in the Tax Return Viewer.

Tax Return Viewer

The Tax Return Viewer is your centre for managing tax returns and the submission process.

To open the viewer:

Click Return on the main toolbar.

Using the navigator, open Tax Return and Computations > SA100 Tax Returns > Current

Working Figures (or any other copy available).

Menu
You can access all the functions of the Tax Return Viewer from the menu. Many of the options will

also be available in the Tasks pane.
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Toolbar
The most popular Tax Return Viewer functions are available on the Toolbar. You'll findmany of

these options repeated in the Menu or the Tasks pane.

Tasks
The most common tasks you're likely to use the Tax Return Viewer for are available in the Tasks

pane. Click on a task to start each process.

Note: The actual tasks available to you are dependent on your access rights in Sage Taxation. If

you click on a task and get a message about increasing your access rights, speak to your

administrator.

Forms
The Forms pane is an easy method of moving through the Tax Return. This is similar to the main

navigator in Personal Tax so you'll already be familiar with it. Click on a page to jump straight to that

page.

17



Chapter 6

Tax return
The page of the return being viewed is displayed in the large preview area. Use the scrollbars to

move through the page being displayed.

View data entry warnings

The Data Entry Warnings window will show a list of areas of the return that are incomplete. You can

print the list and then return to the data entry pages to complete the relevant sections.

A more complete validation is carried out when you click the Validate return task.

To view the data entry warnings:

1. Open the Tax Return Viewer

2. From the Tasks pane click View data entry warnings. The Data Entry Warnings window

appears.

3. A report on incomplete or estimated data entry is prepared. You can print this to help work

through the list, reviewing each source.

Edit payments and balances

Click Edit payments and balances in the Tasks pane to open the Payments and Balances window.

If you change any figures on this window, click Recalculate to make your changes take effect.

Tax owed/Tax overpaid
This is the total amount of tax that the client owes or has overpaid for the currently selected tax

year. You cannot change this default amount.

Payments due
In the situation where you need to increase the payments made on account, for example where
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reductions may have been claimed erroneously and additional payments are required immediately,

you can manually edit the values.

Increase to 31st January <tax year> payment on account.

Increase to 31st July <tax year> payment on account.

Balancing payment for year to 5th April <tax year>

If 'No Claim' has been selected on the Main Details page of the Repayments form, and a

repayment is due, the repayment will be offset against the first payment on account, to

show a reduced payment amount. A negative value indicates that there is an overpayment

which is to be used to reduce the first payment on account.

If a claim is made 'Via SA100' on the Main Details page of the Repayments form then the

amount shown here will be the full payment.

First payment on account for year to 5th April <next tax year>
The value for the first payment on account for the next tax year will be displayed here.

Total payment due on 31st January <next tax year>
This is the Balancing payment plus the first payment on account for the next tax year.

Second payment due on 31st July <next tax year>
This is the second payment on account for the next tax year.

Life Insurance Gains

The Life Insurance Gains window displays details you've entered in the data entry forms (at the time

the copy of figures was taken).

Changes you make in this window will be reflected in the copy of figures only.

View the Plain Paper Calculation

The Plain Paper Calculation (PPC) will give a report of the client’s income and any losses, deductions

or relief, to give a final amount of tax to be paid. The PPCwill be produced for the year currently

selected for the client. Generally this will be the previous tax year currently being worked on.

You can also view the PPC from the Annual Data Navigator, by clicking Calculation on the toolbar.

Find errors with the return

Personal Tax validates the SA100 tax return according to the rules laid down for submission by Filing

By Internet Returns by HM Revenue & Customs. A return must pass these validations before it can

be submitted via the Internet. We also recommend validating your paper returns before submitting

to reduce the chances of the return being rejected.
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As part of filing online, your clients' returns are validated by HMRC servers. There are some

instances where the HMRC server will incorrectly report a data validation error against a submitted

return. See Special Cases and Exclusions in the Help to see how this might affect your clients'

returns.

Validations are performedwhenever the figures are recalculated:

when you open the Tax Return Viewer, or

when you generate a final return,

To find errors within the return:

1. With the return open in the Tax Return Viewer, click Validate on the toolbar. If the validation

finds errors, the Validations pane appears at the bottom of the viewer.

2. Double-click an error to go to that place in the return.

3. If you want to print a list of the errors, so that you can return to the data entry forms and

make all changes, right-click on the Validations pane and choose Print Validation Errors.

Notes

The return must pass ALL validations with no errors before it can be filed by Internet.

You should correct the information in the appropriate data entry form then generate a new

final return. You should not correct the error by manually editing the return. If you do this,

the Current Working Figures and all copies generated from them will still contain errors.

Copy return for editing

You can make a copy of a return, which will be a snapshot of the figures at the time that the copy

was taken.Whereas a return from Current Working Figures will always be up to date, copies of

figures will not reflect changes you make in the data entry forms.

You may want to create copies of figures:

To change the values on a return without affecting the underlying data.

To add attachments to a return.

Tomanually edit the return within the viewer. You cannot manually edit a return in the

viewer using the current working figures.

Note: Using the data entry forms is the preferred way tomake changes to the figures on the

return. This is the only way tomake sure that your changes appear in all current working

figures you generate for that client.

Tomake a copy of figures:

1. Open the Tax Return Viewer.

a. In Personal Tax, use the navigator to find Tax Returns and Computations > SA100 Tax

Returns If an R40 has been selected, this will be Tax return and computations > R40

20



Sage Personal Tax

Tax Returns.

b. Double-click Current Working Figures.

2. From the Return menu choose Copy Figures.

3. You will be asked to enter a name for the copy of the return. You can give it any meaningful

name, or you can use the date and time stamp that is given by default.

4. The new copy will appear in the Tax Return Viewer.

To switch between copies of figures:

1. In the Tax Return Viewer, click the drop-down arrow at the top of the navigator.

2. Click the name of the copy that you want to show, and it will appear in the Tax Return

Viewer.
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Submitting the tax return

There are twomethods of submitting the client's tax return.

By paper

By Internet

Both methods use the Submission wizard to walk you through the submission process. You can

close this wizard at any point during the process. When you want to continue with the submission

simply click Continue submission process in the Tasks pane. The submission wizard opens at

whatever stage you left it. You can also click Back at any time tomove back a stage. As stages of the

submission process for a return are completed, the dates you enter will appear on the Dates page in

Control Centre.

File a return by paper

If you choose to file by paper, you (or your client) will print out a copy of the return for filing.

When using this method, it's not necessary for the return to pass all validations. Personal Tax will

allow you tomark the return Filed even though it failed some of the validation rules. We recommend

that you ensure the return has passed validation prior to filing.

To file by paper:

Send the return to the client:
1. Click Return on the toolbar. The Tax Return Viewer opens.

2. Choose the figures you want to submit from the drop-down list above the Tasks pane.

3. If you are using the Current working figures, click Generate final return in the Tasks pane.

If you are using a copy of the return, click Finalise return for submission.
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4. The return will be validated.

If there are any data entry warning, you will be prompted to correct these before

continuing.

The return is also validated using Filing by Internet rules. This can be a good indication

of whether the return is ready to be filed. Validation errors appear in a pane at the

bottom of the previewer area.

Tip: We recommend that you address data entry warnings and validation errors before

continuing tomake sure the return is accepted by HMRC.

5. When you're ready to continue, a Finalise Return window appears. Enter a name for this

return.

6. From the Tasks pane, click Start Submission process. The Submission wizard appears.

7. Choose File on Paper.

Note: If the return has failed validations, File on Paper will be the only option available.

8. Click Next. The Send Return to Client page appears. Enter the date you sent, or will send, the

return to the client. You can send the return two ways:

Click Print Return. The Print window opens. Choose your print options then print the

return and send it to your client.

Click Save Return as PDF. The Save as PDF window opens. Choose your options then

save the return. You can then send the PDF to your client as an email attachment.

9. Click Next.

Note: At this stage, you will have sent the return to the client andwill be waiting for them to

review and sign it. Personal Tax expects you to close this wizard and continue with it when

you receive approval from your client.

10. Click Close.

When the client approval has been received:
1. Click Return on the toolbar. The Tax Return Viewer opens.

2. Make sure you have the copy of the finalised return selected in the drop-down list above the

Tasks pane.

3. Click Continue submission process. The Submissionwizard appears.

Tip: Make sure you're on the Client Approval page.

4. Select Yes and enter the date of acceptance.

5. Click Next. The Submit Return to HMRC page appears.

6. Enter the date you submitted the return.
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7. Click Next.

Note: At this stage, you will have submitted the return to HMRC andwill be waiting for a

submission response. Personal Tax expects you to close this wizard and continue with it

when you receive a response from HMRC.

8. Click Close.

When a response has been received by HMRC:
1. Click Return on the toolbar. The Tax Return Viewer opens.

2. Make sure you have the copy of the finalised return selected in the drop-down list above the

Tasks pane.

3. Click Continue submission process. The Submission wizard appears.

Tip: Make sure you're on the HMRC Response page.

4. Enter the date of the response.

5. Click Next. The status of the return changes to submitted.

6. Click Close.

File a return online

To file a return online, Personal Tax is used to prepare each client's return for submission, validate it

and send a copy to the client for approval or for reference. You can then file the return individually,

or file multiple returns online at once.

Before you begin

Your practice must be registered for FBI with HMRC.

Make sure you've entered your HMRC User ID and password. From Tools, choose Online

Filing > Online Filing Credentials

To file online:

Send the return to the client:
1. Click Return on the toolbar. The Tax Return Viewer opens.

2. Choose the figures you want to submit from the drop-down list above the Tasks pane.

3. If you are using the Current working figures, click Generate final return in the Tasks pane.

If you are using a copy of the return, click Finalise return for submission.
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4. The return will be validated.

If there are any data entry warning, you will be prompted to correct these before

continuing.

The return is also validated using Filing by Internet rules. Validation errors appear in a

pane at the bottom of the previewer area.

Note: If the return has failed validations, File on Paper will be the only option available. You

must correct failed validations in order to file online.

5. When you're ready to continue, a Finalise Return window appears. Enter a name for this

return.

6. From the Tasks pane, click Start Submission process. The Submission wizard appears.

7. Choose File Online.

8. Click Next. The Send Return to Client page appears. Enter the date you sent, or will send, the

return to the client. You can send the return two ways:

Click Print Return. The Print window opens. Choose your print options then print the

return and send it to your client.

Click Save Return as PDF. The Save as PDF window opens. Choose your options then

save the return. You can then send the PDF to your client as an email attachment.

9. Click Next.

Note: At this stage, you will have sent the return to the client andwill be waiting for them to

review and sign it. Personal Tax expects you to close this wizard and continue with it when

you receive approval from your client.

10. Click Close.

When the client approval has been received:
1. Click Return on the toolbar. The Tax Return Viewer opens.

2. Make sure you have the copy of the finalised return selected in the drop-down list above the

Tasks pane.

3. Click Continue submission process. The Submissionwizard appears.

Tip: Make sure you're on the Client Approval page.

4. Select Yes and enter the date of acceptance.

5. Click Next. The Ready to File page appears.

6. Click Close.

File the return online:
1. Close the Tax Return Viewer by clicking the Close button on the toolbar.
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2. Choose Tools > Online Filing > File Returns. The Online Filing window appears.

Note: If there are returns available to file from more than one year you'll be able to select

and process the earlier years before moving on to the later years.

3. Select the return to file then click the arrow button tomove the return to the Returns to file

list.

4. Click File. Progress bars appear showing the submission status.

When a response has been received by HMRC:
1. Click Return on the toolbar. The Tax Return Viewer opens.

2. Make sure you have the copy of the finalised return selected in the drop-down list above the

Tasks pane.

3. Click Continue submission process. The Submission wizard appears.

Tip: Make sure you're on the HMRC Response page.

4. Enter the date of the response.

5. Click Next. The status of the return changes to submitted.

6. Click Close.
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Year Update

When you set up a client in Personal Tax you will have one tax year available to enter data for.

Before you can work on subsequent tax years you will need to year update.

Year updating carries forward (or backwards) information that is unlikely to change on a year-on-

year basis. For example, if you create an employment 2005 and year update to 2006, then main

details of the employment will carry forward to 2006 saving you the trouble of re-entering them.

We'd recommend year updating all your clients at the beginning of the tax year rather than on an

individual basis. Your clients will then all be included in progress reports for the year.

If your client operates a new business but is behind in filing returns, you may need to create

the previous tax year before year updating to work on the current tax year.

Clients that have transferred from other practices will have previous returns. It may be

useful to take this information and enter data in the previous year so you have a fuller record

of their tax history.

Note: Sage Instant Taxation customers are not able to year update to the 2011 tax year.

To year update a client's data:

1. From the Tools menu, choose Year Update. The Year Update window appears.

2. Select the year to update from. You can update from any available year, but if you choose to

update to an existing year; data will be overwritten. You will be warned if you try to do this.

3. If you are year updating to the current tax year and you want to mark the figures as

estimated in the new year, tick the box.
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4. Click OK. Your client's data will be carried forward or back, depending on your choice. A

message will appear when the update it complete.

5. The new year will now be available in the Annual Data Navigator in the year drop-down list.
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Other features

Here is an overview of a few of some of the other features available in Personal Tax.

Annual Processing Log

You can open the Annual Processing Log by choosing Processing Log... from the Tools menu.

Personal Tax automatically records progress by inserting dates into the Annual Processing Log. The

word Automatic appears alongside these dates in the log (this marker disappears if you then edit the

date). You can keep amore comprehensive record by inserting further dates manually into the log.

You can choose to overwrite all dates in the Annual Processing Log. The dates are ordered into

different categories, which appear on separate pages e.g. Preparation, Payments.

All of the dates within the Annual Processing Log can also be seen in Control Centre. Most of the

dates are 'tax-year specific dates' and can be found by selecting the appropriate tax year. Dates

relating to statements of account are 'fixed dates' which means that only one date will exist relating

to all years.

Repayment claims

Use the Repayments form to enter details about a claim for repayment of excess tax paid. All details

you enter on this form are used in the Other information section of the return.

Click Repayments on the navigator to open the form.
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Choose how to claim a repayment by selecting one of the options:

No claim

Claim via SA100

Claim via R40

If you choose tomake a claim, other tabs will become available to identify how you would like the

claim to be repaid.

Claim to reduce client's payments on account

Use this form if the client is claiming to reduce their payments on account.

These details are used in HM Revenue & Customs form SA303.

Click Claim to reduce payments on account to open the form.

Choose how to claim a payment on account by selecting one of the options:

No claim

Via SA303 form

Via Tax Return

If you choose tomake a claim, you will also need to complete the details on the Reclaiming tab.

Depending on the options you choose, the Payment and Agent's Details tabmay also become

available.
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Blank tax forms

You can view the SA100 and all schedules, plus the P11D, SA303 and R40 with no data entered.

These are useful if you need to print out any blank forms for completingmanually.

From the Tools menu choose Blank Forms, then your selection. The blank form opens with it's name

showing at the top of the navigator. Details about the form appear on the status bar at the bottom

of the page.

Note: Sage Instant Taxation customers are not able to view the P11D.
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Product training

Sage offers both standard and tailored training courses. Sage can advise you on your training needs

and recommend appropriates individual or group courses, which we can run at your offices or at one

of the Sage training centre throughout the UK. Product training can benefit all Sage Taxation users -

even the most experienced ones. To receive details of courses available, contact your Account

Manager on 0845 111 11 11.

To view available courses, go to the Sage website at www.sage.co.uk/accountants and choose

Training for Practice in the left handmenu.
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